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Typography

In this document, the following typographic conventions are used:

Normal Normal text is used for the body of the document.

CB The name of this program is always printed in bold italics, to distinguish it from
the generic term for Citizen’s Band radio.

AUTOEXEC.BAT Computer-generated things like filenames are printed in Courier type, to avoid
confusion with standard English words.

copy *.* b: Things typed at the keyboard are printed in bold Courier.

emphasis Simple italics are used for emphasis, and to introduce new terms for the first
time.

{Alt-H} PC keypresses are shown as key names within braces.

ASCII The actual contents of files are printed in small Courier. They are printed in
Courier in order to achieve fixed character spacing, which is how you would see
the contents on a computer screen or listing. They are small in order to fit 80-
character lines well within the margins of the printed page, without causing an
artificial line wrap which does not exist in the data itself.

Typography CB User’s Guide Page 1
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  Requested Item  Quantity  Unit Price  Total

CB Registration: 1 user for 1 year 20.00

CB User’s Guide (this document) 40.00

Other CCS Products (specify):

 Total order

 Virginia Residents add 4.5% tax

 Amount due

CB Registration Order Form

Mail to: CB Registration
Computerwise Consulting Services
P.O. Box 813
McLean, VA 22101

From:

Figure 2: CB  Registration Order Form
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Registration of this Software

This program will only run properly when it detects the presence of a valid registration serial number. This prevents
the use of this program by folks who haven’t paid for it. Shareware, after all, means “Try it before you buy it”, not
“Try it, like it, and keep using it without paying for it”.

Registration serial numbers may be obtained from CCS for the price of $20 per user per year. Orders may be placed
with CCS at the following address:

CB Registration
Computerwise Consulting Services
P.O. Box 813, McLean, VA 22101
(703) 450-7175

Be sure to indicate the number of registrations desired (@ 1 per user), and to include payment for each such registra-
tion. The attached order form (see Figure 2) may be copied and used for this purpose.

Once a registration serial number has been obtained from CCS, it may be specified to this program in one of three
ways:

• Via a “Registration=xxxxxxx” command in each user’s personal CB_USER.CFG configuration
file. See “Configuration Files” in the next chapter.

• Via a “CBSERIAL=xxxxxxx” DOS environment variable. See “DOS Environment Variables” in the
next chapter.

• Via a “-#xxxxxxx” command-line flag provided on the command line when the program is run. See
“Command-line Flags” in the next chapter.

Remember — each user of this program needs to pass to CB his own personal registration serial number in order to
be able to talk to other CB users.

You may install as many copies of this software as you like. You may make backup copies
of this software, because it is not copy-protected. In short, you are not constrained in any
way from performing prudent software installation, distribution, or backup with this product,
as any responsible network administrator will no doubt do with all network software that he
owns. The only restriction is that each user must have his own individual serial number as
described above.

Introduction and Installation CB User’s Guide Page 6
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window A window is a boxed portion of the screen which displays data for one channel.
The upper portion of the window displays messages which have been received

on that channel, and may be scrolled backwards to view messages which have
disappeared off of the top of the window. The lower portion of the window is a
single line, and holds the current line which is being prepared for transmission

on that channel. This is the transmit line. You may have multiple windows on
the screen at one time, each monitoring a different channel.

window title line The window title line is the top line of the box which surrounds a window. This
line is used to identify the channel with which this window is associated.

Installing Joan Riff’s CB Simulator on a Network

Before it can be used, CB must be installed on a network by the network administrator. Because CB is a network
“groupware” application, its installation is somewhat more involved than is necessary for a stand-alone program.
Nevertheless, its installation can be reduced to the following simple steps:

1) Obtain one registration serial number from Computerwise Consulting Services for every network user that
you want to have access to CB. See “Registration of this Software” (below) for detailed information
about the registration process.

2) Create a directory somewhere on a network drive to which all potential users will have access. Use your
network’s administrator utility to give all users full access to this directory. All users must be able to search
this directory for files, create files under this directory, and read/write all files under it.

3) Copy the following CB files to some directory on the network which is in every user’s search path:

CB.EXE The executable program itself.
CB_SITE.CFG The site-wide configuration file.
CB_USER.CFG A sample user-specific configuration file.
CB.HLP The Online Help Facility text file.

4) Edit the CB_SITE.CFG file (which you just created in step 3) to reflect your own site-wide preferences. It
is especially important that you change the “Directory=” parameter so that it names the network direc-
tory that you created in step 2. Be sure to include the trailing ’\’ character in this directory name!

5) Using the registration serial numbers obtained from CCS, you must install each CB user using one of the
following techniques (it’s your choice):

a) You can create a unique batch file for every user (CB_BOB.BAT, for example), and store it in a net-
work directory which is in every user’s search path. Each such batch file should invoke CB with com-
mand-line flags which specify this user’s serial number and handle. See “Command-line Flags” in the
next chapter.

b) You can copy the sample CB_USER.CFG file (created in step 2 above) to a directory which appears in
this user’s DOS search path prior to any other directories, and then edit that file to contain this user’s
individual serial number and handle. This will cause CB to automatically find this file and obey the
parameters contained in it. See “Configuration Files” in the next chapter.

c) You can edit each user’s AUTOEXEC.BAT file on his boot disk to set his serial number and handle
via DOS environment variables. See “DOS Environment Variables” in the next chapter.

The program is now ready to be used. Installation is complete.
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message A message is a single line which is transmitted over a channel. The transmit line
at the bottom of the current window holds the message which is currently being
constructed for transmission. When you press the {Return} key to transmit the
message, then the message is transmitted and the transmit line is cleared to start
a new message. Received messages are identified on the left with the handle of
the person who transmitted the message, so that you can keep track of who says
what when many users are on the same channel.

registration Each user of this software product must be registered with CCS in order to com-
ply with the copyright, and to ensure that this software is used only by users
who have legally purchased the right to use it. The process of registration is
fully described in “Registration of this Software” below, and in other places
where the use of registration serial numbers is discussed.

transmit line The transmit line is the one-line subwindow at the bottom of a screen window.
This space holds the single line which is being prepared for transmission over
that window’s channel. All keypresses which are not CB commands are stored
in this line for eventual transmission over the channel when you press the
{Return} key.

Window for
Channel 19

Window for
Channel 01

Messages
received on
Channel 19

Transmit Line
for Channel 01

Current date and
time

Insert/Overwrite
indicator

MiniHelp Line

Copyright Line

Program title, version, and date of
compilation

Handle of message’s
originator

Transmit Line
for Channel 19

Figure 1: Terminology and the main CB screen
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• Messages may be scrambled with a password in order to obtain a measure of privacy.
• Messages may have attributes attached which cause them to beep and/or be displayed in an alternative

color when received.
• Messages which have scrolled off of the top of the window may be reviewed by scrolling backwards and

forwards through them.
• Context-sensitive help is always just a single keypress away.
• Operation is configurable via configuration files, environment variables, and command-line flags.
• Individual users may be filtered out (disabled), so that irrelevant messages don’t clutter your screen.
• This software runs on any network which provides multi-user access to a DOS directory — it is not depend-

ent upon any specific network.
• Up to 50 distinct handles (hence users) may be “on the air” at one time. The practical upper limit depends

upon the efficiency of your network.
• All of the PC’s free real memory is used to hold incoming messages.
• Common operations are handled immediately from the main screen, making CB very easy to use.
• Advanced operations are handled from within a pulldown menu interface which allows you to navigate

through all applicable choices before committing yourself.
• A revolutionary new approach to software registration protects this software against unauthorized use,

while giving registered sites unrestricted access to the software.

CB Terminology

This section introduces terms which apply to this software product. Please refer to Figure 1, which applies these
terms to the main CB display screen.

channel A channel is a medium of transmission. The use of channels serves to com-
partmentalize communications, in that what is transmitted over one channel can
only be received by users who are monitoring that channel. Each window on the
screen has a title line which describes the channel with which that window is as-
sociated. There are 19 simulated channels available to the user of CB.

channel name A channel name is the name associated with a channel. Channels are named via
parameters in the CB configuration files (see “Configuration Files” in the next
chapter). A channel name is displayed in the window title line at the top of each
screen window, showing the channel with which that window is associated.
Channel names are also used as an informal, site-specific guide to their use.

conference A conference is the sum total of all messages that are transmitted by all users on
a particular channel. It is called a conference because in terms of what is said
and heard it is exactly as if all participants were in the same room and would
hear whatever is said by any single participant, whereas users of other channels
would not be heard.

current window The current window is the window into which you are typing. It is highlighted
on the screen to differentiate it from any other windows which may be on the
screen. When you press the {Return} key to transmit a message, that message
gets sent over whatever channel is associated with the current window.

handle A handle is the name by which the user wants to be known to his CB audience.
It can be anything at all: a real name, a nickname, initials, or whatever. It may
be up to 16 characters long. Every received message is identified on the left by
the handle of the transmitter of that message.
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Introduction and Installation

About CB Radio Itself

This section provides a brief overview of CB radio, for those users who may not have been part of the CB craze
which swept this nation back in the late 1970’s. This short technical discussion is necessary in order to make clear
the analogy between real CB radio and this software package.

Citizen’s Band (CB) radio exists to allow the average American to use the radio waves without having to become a
communications expert. A CB radio is simple to use, and allows many people to carry on a simultaneous conversa-
tion over the airwaves.

Using a CB radio is as simple as:

• Turning on the radio.
• Selecting one of the 19 available radio channels1.
• Speaking into the microphone.

Whatever you say into the microphone is immediately heard by everybody else who has a CB radio which is tuned
to the same channel. By the same token, you can hear what is said by everybody else who is transmitting on your
channel.

What is Joan Riff’s CB Simulator?

Joan Riff’s CB Simulator for PC Networks (hereinafter referred to simply as CB) is a software product for use on
PCs that are connected to a local area network. Simply stated, CB is the digital equivalent of a CB radio. CB allows
users of a network to carry on a multi-party simultaneous conversation, or conference.

Operation is simple: the user simply types lines of text. Every line that the user types appears on the screen of every
CB user, and lines typed by all other CB participants appear on the user’s screen.

CB Capabilities at a Glance

This CB simulator provides the following features:

• Any of 19 simulated CB channels may be used.
• Multiple users can be transmitting on a channel at one time.
• Multiple windows can be on the screen at once, each associated with one channel.
• Each user has his own handle by which he is identified, and which gets attached to his messages.
• Incoming messages can be logged to a Logfile.
• ASCII files may be transmitted across a channel as if typed by a user.

Introduction and Installation CB User’s Guide Page 2
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**********************************************************************
*
* This is the configuration file for an individual user. This should
* be placed in the user’s DOS search path such that it will be found
* when the program is run by this user and no other.
*
* This file should define user-specific items like the user’s
* registration number, his handle, etc. It should not define those
* things which are site-wide, like the channel assignments, the
* refresh rate, etc.
*
* Items in this file will override corresponding items in the
* site-wide configuration file "CB_SITE.CFG".
*
**********************************************************************

*
* Set the following to your own individual registration number.
* In order for the program to provide full functionality, every
* user of CB must have his own individual registration serial
* number.
*
* Such registration numbers may be obtained from CCS at:
*
* CB Registration
* Computerwise Consulting Services
* P.O. Box 813
* McLean, VA 22101
* (703) 450-7175
*

Registration=10G3-CB67GD.R18

*
* Set the following to the handle that you want to be known by
* on the air. Every message that you send will have this handle
* attached to it.
*

Handle=Joan Riff

*
* If desired, set the following to the name of the default
* file to be used as a Logfile.
*

Logfile=.\CB.LOG

*
* The following can be set to "Yes" or "No" to allow or suppress beeps
* and things.
*

Sound=No

Figure 5: The user configuration file CB_USER.CFG
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**********************************************************************
*
* This is the configuration file for the entire site. This should
* be placed in the system’s DOS search path such that it will be found
* when the program is run by any user. The best place to keep this
* file is in the same directory as the executable program CB.EXE.
*
* This file should define site-wide items like the default channel
* assignments, the default refresh rate, etc. It should not define
* those things which are user-specific, like a registration number.
*
* Items defined here can be overridden by corresponding entries in
* each user’s individual configuration file "CB_USER.CFG".
*
**********************************************************************

*
* The following defines whether the introductory copyright screen
* will be displayed until you press a key. Note that this only
* applies if this is a registered copy of the software. If there
* is something wrong with the registration number, then the
* initial copyright screen will be displayed (explaining the
* problem) regardless of the setting of this variable.
*

Copyright=No

*
* Set the following to the number of seconds between checks
* for new messages. If you are running on a fast network, then
* make this number small (say 1 or 2). If your network is
* slow, then bump this up to 4 or more.
*

Refresh=1

*
* Set the following to the DOS command which is used to page
* a network user who is not currently on CB. Use "\N" in
* this line for any place where the network name of the paged
* user should appear.
*

Page=SEND "You are wanted on the CB!" TO \N NUL

*
* Set the following to the name of a network directory under
* which CB should look for its files. This directory must be
* accessible to all users of CB, and everybody should have
* full permissions to this directory and all files under it.
* This MUST include the trailing ’\’ character! *

Directory=f:\sharedir\cb\

*
* Names of (and implied uses for) the various CB Channels.
* Change these to whatever is meaningful to you.
*

Channel 01=Initial Rendezvous
Channel 02=Unassigned
Channel 03=Unassigned
Channel 04=Unassigned
Channel 05=Unassigned
Channel 06=Unassigned
Channel 07=Unassigned
Channel 08=Unassigned
Channel 09=Emergency Communications
Channel 10=Unassigned
Channel 11=Unassigned
Channel 12=Unassigned
Channel 13=Unassigned
Channel 14=Unassigned
Channel 15=Unassigned
Channel 16=Unassigned
Channel 17=Unassigned
Channel 18=Unassigned
Channel 19=General Communications

*
* The following can be set to "Yes" or "No" to allow or suppress beeps
* and things.
*

Sound=No

Figure 4: The site configuration file CB_SITE.CFG

CB User’s Guide Page 14

Copyright © 1990 Computerwise Consulting Services
All Rights Reserved



Registration=xxxxxxx Specifies your personal registration serial number. Each user must have his own
distinct serial number, as provided by CCS. This number may be specified here,
in the DOS environmemt variable CBSERIAL, or on the command line that in-
vokes CB as the command-line flag “-#xxxxxxx”. The program will not be
fully functional until and unless a valid such number is presented to it through
one of these methods.

Sound=Yes | No Specifies whether sound is to be used (Yes) or suppressed (No).

The Copyright Screen

Unless you have asked that the copyright screen be suppressed (see “Copyright=” above), CB always displays its
copyright screen when it begins execution. This screen (see Figure 3 below) remains displayed until you press
{Return} to clear it and begin simulation. This screen will also be displayed regardless of the “Copyright=” set-
ting if there is anything wrong with the registration serial number. Assuming that this is a properly registered copy
of this software, the top line shows how many months are left until the registration expires.

This screen explains our rights under federal copyright law. Please do not attempt to circumvent the conditions
which are explained in this screen, for CCS will vigorously defend its copyright in order to keep this software from
falling into the public domain.

Figure 3: The CB copyright screen
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Directory=xxxxxxx Specifies the name of a network directory under which this program is to create
its temporary message files, and under which it will look for other users’ traffic.
This is the same directory which was created in Step 2 of the installation se-
quence presented in the last chapter. This must be a complete network path, in-

cluding the trailing ’\’ character. A failure to specify the name of an existing
directory will cause an error when the program tries to establish its network con-
nection.

Handle=xxxxxxx Specifies the CB handle that you will be known by. Each user should have a dis-
tinct handle, although (as with a true CB radio) this is not enforced. This handle
may be specified here, in the DOS environment variable CBHANDLE, or on the
command line that runs CB as the command-line flag “-hxxxxxxx”.

Logfile=xxxxxxx Specifies the default name to be used for the Logfile, to which incoming mes-
sages are written when Logging is turned ON. You are given the chance to ex-
plicitly specify the name of the file to be written. This item exists just to provide
a convenient default.

Page=xxxx Specifies the DOS command which is to be used to page somebody on your par-
ticular network. When you ask this program to page somebody, it will pass to
DOS the command which you have specified here. You reserve space in the
command for the user’s network name by inserting the reserved string “\N”.
This will be replaced with the name of the user that you are paging.

On a Novell network, for instance, you can page somebody using the Novell-
supplied program SEND. So your entry could read as follows:

Page=SEND "You’re wanted on CB!" TO \N

Note that the string “xxxx” may contain embedded escape sequences for those
characters which can’t easily be entered from the keyboard. These are translated
by CB before the string is passed to DOS for execution. These escape sequences
are as follows:

\r becomes a Carriage Return
\n becomes a Line Feed
\b becomes a Backspace
\t becomes a Tab character
\f becomes a Form Feed
\xFF becomes a byte with the hexadecimal value FF
\000 becomes a byte with the octal value 000

This Page= variable is merely a convenience, useful only if you want this pro-
gram to do the paging for you. You could accomplish exactly the same effect by
issuing the appropriate DOS command yourself from within this program.

Refresh=n Specifies the number of seconds between checks for new messages. The argu-
ment n may be from 1 to 29. The smaller the number, the more responsive the
program will be to new traffic, at the expense of increased disk activity. A larger
number will mean that more time may elapse between the time that a message is
posted and it appears on your screen, but the program will pay more attention to
your keyboard and will place less of a burden on your network.
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CB_SITE.CFG This is the site-wide configuration file, which defines parameters which apply to
all users on the network. Figure 4 is an example of such a file.

CB_USER.CFG This is an individual user’s configuration file, which modifies CB according to
the individual user defined by this file. Figure 5 is an example of such a file.

Neither file is absolutely required, although you are strongly encouraged to have at least the site configuration file
CB_SITE.CFG.

Configuration File Commands

Each line of these configuration files is of the form Keyword=Value. The left side of the equation (up to and in-
cluding the equals sign) is a literal which must be entered exactly as shown, including upper- and lower-case charac-
ters and embedded spaces. The right side of the equation is set by you. There are various types of entries, which are
shown in the following examples as follows:

xxxx The string “xxxx” stands for any string of your choice.

Yes | No One value must be entered, either “Yes” or “No”.

n A number must be entered.

The various literal keywords which are recognized are as follows:

Channel 01=xxxx

Channel 02=xxxx

Channel 03=xxxx

Channel 04=xxxx

Channel 05=xxxx

Channel 06=xxxx

Channel 07=xxxx

Channel 08=xxxx

Channel 09=xxxx

Channel 10=xxxx

Channel 11=xxxx

Channel 12=xxxx

Channel 13=xxxx

Channel 14=xxxx

Channel 15=xxxx

Channel 16=xxxx

Channel 17=xxxx

Channel 18=xxxx

Channel 19=xxxx These entries specify the names for simulated CB Channels 01 to 19. The
various channels have no preassigned uses, other than the convention that Chan-
nel 01 is used for the initial rendezvous between two users that have not agreed
beforehand on a channel to meet on. You may use these variables to assign
names to the channels, and thereby to establish site-wide conventions for their
use.

Copyright=Yes | No Specifies whether the copyright screen is to remain on the screen (Yes) or is to
be cleared (No) at program startup. If there is anything wrong with the registra-
tion serial number, then this screen is presented regardless of the setting of this
variable.
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SET CBHANDLE=xxxx

SET CBSERIAL=xxxx

The purpose of these variables is to specify your individual serial number and handle so that CB can locate them
when it begins execution. If you set these variables in the AUTOEXEC.BAT file of your system’s boot disk, then you
can just run the program directly via the DOS command “CB”, without having to have an individual batch file
created for you just to specify these things via command-line parameters.

Searching for Files via the DOS “PATH”

CB uses auxiliary files (the configuration files, its Online Help file) for various purposes. When the program sear-
ches for these files, it does so by looking first in the current DOS directory, and then in every directory that is
defined in the DOS PATH environment variable. This series of directories is sometimes known as the DOS search

path. Your DOS manual describes how to set and use this environment variable.

When CB enters execution, it searches the DOS search path for an ASCII text file named CB_SITE.CFG. This file
— if found — is used to initialize various configuration variables used by CB as it executes. This file is meant to
hold site-wide settings, which serve as defaults.

After searching for that file, CB then searches for a similar file called CB_USER.CFG. This will typically reside
within an individual user’s own disk space, and is used to further customize CB’s operation. Any values which are
defined in this file will override the defaults that were specified in CB_SITE.CFG.

Lastly, CB searches for a file named CB.HLP, which holds the text of the Online Help screens.

It is important to remember that the search for these various files procedes through all directories in the PATH string
in the order in which they appear. Assume that the PATH string has been set as follows:

PATH=c:\bin;c:\mystuff;f:\cb_stuff

Now assume that there are three files named CB_USER.CFG in three separate directories:

F:\BBAUMANN\CB_USER.CFG

C:\BIN\CB_USER.CFG

F:\CB_STUFF\CB_USER.CFG

The file at C:\BIN\CB_USER.CFG is the one that will be found and used by CB.

If you meant the file at F:\BBAUMANN\CB_USER.CFG to be the one to be used, then that’s tough. The directory
F:\BBAUMANN isn’t even in the DOS search path, so it will not be searched (unless it just happens to be the current
DOS directory).

If you meant the file at F:\CB_STUFF\CB_USER.CFG to be the one to be used, then that’s tough too. Once CB

finds the file that it’s looking for (in this case, the file at C:\BIN\CB_USER.CFG), it stops looking. This, by the
way, is very useful when you want to override the file at F:\CB_STUFF\CB_USER.CFG by having the program
use the one at C:\BIN\CB_USER.CFG instead.

Please remember this when setting up your own files. Make sure that you place them so that the above-described
search will find the proper files in the proper order.

Configuration Files

The behavior of CB can be modified by commands contained in two configuration files:
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-o Suppresses the loading of the Online Help file CB.HLP. This will save the
memory normally occupied by that file, thus increasing the amount of memory
available for holding incoming messages, or for DOS commands which you
may want to run. This also means, of course, that Online Help will be unavail-
able to you.

filename Any command-line flag which does not start with a ’-’ (hyphen) is assumed to
be the name of a configuration file which is to be processed. Such files are
processed after the CB_SITE.CFG and CB_USER.CFG configuration files, so
any variables set from such files will override prior values.

For example, you may start the program and specify your CB handle at the same time with:

CB -hMyHandle

None of these flags are required. They exist as a convenience for your network administrator, so that he may create a
batch file that will make operation of this program easier for you. For example, the following DOS batch file might
be useful for a site which stores individual CB configuration files under each network user’s home directory on
drive F:

F:\BIN\CB.EXE F:\%1\CB_USER.CFG

If your network name is BBAUMANN, for example, and your home directory on the network is F:\BBAUMANN, and
the above batch file is named CB.BAT, then you could start the program by typing

CB BBAUMANN

This would cause CB to automatically locate and obey your own individual configuration file located at
F:\BBAUMANN\CB_USER.CFG, from which it would read your handle and your registration serial number.

Normally, of course, you wouldn’t want to have to enter such command-line flags every time that you run the pro-
gram. These command-line flags are useful because they can be incorporated into individual batch files, one for each
user of CB.

DOS Environment Variables

An alternative (and preferred) way to pass an individual’s serial number and password to the program is to set up
two DOS environment variables which CB checks for when it runs. This can eliminate the need to build individual
batch files which specify this information via command-line flags.

The following DOS environment variables may be used to pass information to this program:

CBHANDLE=xxxx Sets your CB handle to the name xxxx. This will override any handle specified
in a CB configuration file, but will itself be overridden by the command-line
flag “-hxxxx” (if provided to this program when it is invoked).

CBSERIAL=xxxx Sets your personal registration serial number to xxxx. This will override any
serial number specified in a CB configuration file, but will itself be overridden
by the command-line flag “-#xxxx” (if provided to this program when it is in-
voked).

These may be set in your system’s AUTOEXEC.BAT file (or from the DOS command line) with the following com-
mands:
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Starting CB

NOTE: This chapter describes several ways that the CB program may be started. Much of
this information is useful only to your network administrator as he installs the product. He
may decide to install the product in a manner which may render obsolete some of the
information in this chapter, so check with him for details about the way that he has set up
your individual use of the product.

Invoking CB

Once CB has been installed on your network, running it is as simple as typing “CB” at the DOS prompt. If your net-
work administrator has installed a custom batch file for your use, then instead of typing “CB” you would type the
name of whatever batch file he created for you.

The rest of this chapter explains technical details which would normally be of interest only to your network ad-
ministrator. Nevertheless, advanced users may also find this information to be of interest.

Command-line Flags

The DOS command line which invokes this program will of course begin with the name of the program (“CB”). It
may also contain optional parameters which are specified after the program name. These are called command-line

flags, and they can be used to modify the program’s behavior.

The following flags may be given on the command line which invokes CB:

-hxxxx Sets your CB handle to the name xxxx. This will override any handle specified
in a CB configuration file and in the environment variable CBHANDLE. If there
are blanks in your handle, then be sure to quote the entire flag like this:

"-hCrazy Ivan!"

If you don’t quote it, then CB will treat each word as a separate flag, and in this
example would see the two flags “-hCrazy” and “Ivan!” — which is not ex-
actly what you want.

-#xxxx Specifies your registration serial number. This will override any serial number
specified in a CB configuration file and in the environment variable
CBSERIAL. It must be specified somewhere (in one of these three places)
before the program will become fully functional.

Starting CB CB User’s Guide Page 8

Copyright © 1990 Computerwise Consulting Services
All Rights Reserved



Figure 12: {F1} context-sensitive help for a menu choice
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to the right. Now that long message from Mikey becomes fully visible, and the
handles have disappeared. Many users prefer to keep their windows permanent-
ly scrolled 16 columns to the right, and only scroll back if they need to identify
the author of some specific message.

Context-Sensitive Help: The {F1} Key

If you are ever uncertain about some aspect of CB then just press {F1} (Function Key number 1 on the PC key-
board). The {F1} key is interpreted as a request for help. When pressed, it does one of two things depending upon
what’s going on when it is pressed (that is, depending upon the context within which help was requested):

1) If you are seeing the main CB screen (i.e. — you are not in the middle of a command or a question), then
pressing the {F1} key will give you access to the full Online Help facility. This is a series of screens which
explain various facets of this program. You may page forward and backward through these help screens
with the following keypresses:

{Up} Scrolls the text up one line.
{PgUp} Scrolls the text up one screen.
{Down} Scrolls the text down one line.
{PgDn} Scrolls the text down one screen.
{Home} Goes to the very first screen of Online Help.
{End} Goes to the very last screen of Online Help.
{Escape} Exits Online Help.

Figure 11 shows a sample screen from this Online Help facility.

2) If you are being prompted for some input, or are pointing to some Pulldown Help Menu item, or have been
shown some error message, then pressing the {F1} key will elicit a hint as to what is required or meant by
the prompt or message. This hint will disappear by itself with your next keypress. Figure 12, for example,
shows a hint being displayed because the user pressed {F1} while the Pulldown Menu choice for annotating
the Logfile was highlighted.

Figure 11: A sample Online Help Facility screen
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{Del} Deletes the character at the cursor.

{Ctrl-End} Deletes to the end of the transmit line.

{Ins} Toggles Insert/Overwrite mode on the transmit line. When “Ovr” is displayed
on the transmit line, then characters which you type will overtype those which
are already in the line. When “Ins” is displayed on the transmit line, then char-
acters which you type will push to the right those which are already in the line,
this inserting the new characters between existing ones.

Scrolling Through Received Messages

{Up}
{PgUp}
{Ctrl-PgUp}
{Down}
{PgDn}
{Ctrl-PgDn} These keys scroll the upper part of the current window backwards and forwards

by lines, screens, or the entire in-memory buffer. This allows you to recall mes-
sages which may have scrolled off of the screen.

{Ctrl-Right}
{Ctrl-Left} These keys pan the upper part of the current window to the right and left in units

of 8 columns. This is useful when viewing lines which are too long to be dis-
played within the confines of the window, and for pushing the handles off of the
left edge of the screen so that you can see the largest possible portion of each
message line.

Figure 9 shows a screen before horizontal scrolling. Notice that the handle of the
transmitter of each message is shown at the left side, and that the message from
Mikey exceeds the width of the window. Figure 10 shows the window after
{Ctrl-Right} has been pressed twice to scroll the window a total of 16 columns

Figure 10: The same window after horizontal scrolling
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Obtaining Help

{Alt-H}
{F1} Help. {Alt-H} gives you access to the Online Help facility. What {F1} gives you

depends upon the exact context in effect when you press it. See “Context-sensi-

tive Help” later in this chapter.

Obtaining Pulldown Menus

{Alt-M}
{F2} Menu. Invokes the Pulldown Menu Interface, which is fully described in the

next chapter.

Editing the Transmit Line

{Return} Causes the current transmit line to be transmitted over the current channel. The
transmit line is then cleared in preparation for the next line to be entered.

{Right} Moves the cursor one character to the right.

{Left} Moves the cursor one character to the left.

{Home} Moves the cursor to the far left limit of the transmit line.

{End} Moves the cursor to the far right limit of the transmit line.

{Tab} Inserts blanks up to the next 8-character TAB column.

{Shift-Tab} Deletes backwards to the previous TAB column.

{Backspace} Deletes the character to the left of the cursor.

Figure 9: A window before horizontal scrolling
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dialog box. The two attributes which may be applied are:

Beep Will cause a beep when this message is received.
Color Will cause this message to be displayed in an alternate color.

These attributes remain in effect for the given window until they are changed.
So once you set Beep, for example, then all of your messages will beep when
received until you turn off this Beep attribute.

Figure 7 shows the attributes dialog box at the top of the screen. The current set-
tings of the two possible attributes are shown in parentheses. These are the set-
ting which you change by pressing the {B} or {C} keys. Notice the transmit line
which is being built. The {Return} key has not yet been pressed to transmit this
line, so the indicated attributes will be applied to this message when it is trans-
mitted.

Figure 8 shows the effects of these settings on a message. Here the {Return}
key has been pressed and the message sent. Notice how the message is set off
from other messages by being displayed in a different color.

Switching Channels and Windows

{Alt-C} Channel. Causes the current window to be tuned to the next available active
channel. That new channel’s data is then displayed in this window. This is a
quick way to browse through several channels without having to use pulldown
menus to do so.

{Alt-W} Window. Makes the next window on the screen the current window. This is a
quick way to make another window the current one without having to use
pulldown menus to do so.

Figure 8: The results of applied transmit line attributes
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The Transmit Line

The small, one-line subwindow at the bottom of each window is the transmit line. This holds your current outgoing
message. The contents of this line are transmitted over the window’s channel when you press the {Return} key.

The current window is the one which is highlighted on your screen. As you type characters into the transmit line at
the bottom of the current window, you are composing a message which will be transmitted over that window’s chan-
nel. If the channel on which you are transmitting has been scrambled, then outgoing lines will be automatically
scrambled as they are sent, and can only be meaningfully received by CB users who have likewise scrambled that
channel using exactly the same password.

Received Messages

In the upper half of each window you are monitoring activity on the indicated channel. Any messages that are trans-
mitted (by you or somebody else) on a channel are automatically displayed in the upper part of the corresponding
window. If a monitored channel has been scrambled, then incoming scrambled messages will be automatically un-
scrambled before being displayed, using whatever password you specified when you asked the channel to be
scrambled. If this password is different from the password that was used by the transmitter of a message, then the
received data will appear as garbage on your screen.

Conversing on a CB Channel

Normally, any keys which are pressed by you are inserted into the current window’s transmit line which you are
building. The following keys have special meaning. The discussion of these keys is grouped according to the general
function performed.

Message Attributes

{Alt-A} Attributes. This keypress pops up a dialog box showing various attributes which
may be applied to the transmit line which is being entered. Press the key cor-
responding to the attribute which is to be toggled, or {Escape} to exit this

Figure 7: Applying attributes to the transmit line
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Using CB

Once CB has been invoked, it is extremely easy to use. For most applications, all that you need to do is type lines of
text that you want to broadcast to other users of CB, and watch the responses from those users show up upon your
screen.

The Main Screen

Most of the your time spent on CB will be spent in the main screen, which is reproduced for your convenience in
Figure 6 below. This sample screen contains two windows: one (the upper one) which is currently monitoring Chan-
nel 19, and another which is currently associated with Channel 01.

The Window Title Line

Each window has a title line, which describes the channel with which the window is associated. The channel is iden-
tified by number (01 through 19) and by whatever name has been associated with this channel in the CB configura-
tion file(s). In addition, the channel identification is preceded by several special characters as follows:

+ A plus sign indicates that this channel has been enabled. Enabling channels is described in the next chapter.

- A minus sign indicates that this channel has been disabled. Disabling channels is described in the next chap-
ter.

@ An “at” sign indicates that this channel is being scrambled. Scrambling is described in the next chapter.
The absense of such a character means that the channel is being used in the clear.

Figure 6: The main CB screen
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Rather than having to go through the entire Pulldown Window Interface to accomplish this, you can accomplish the
same thing by pressing {Alt-W} from the main CB screen.

Window Kill

This selection kills the current window (assuming of course that there are at least two windows on the screen), and
gives its space to one of its neighboring windows.

Along with Window Split this command allows you to control the number of windows on your screen.

Window Split

This selection splits the current window into two, assuming of course that the window being split is large enough to
support two separate windows. The two windows thus created are initially pointing to the same channel, but now
that they are two separate windows you may independently change each window to suit your needs.

Along with Window Kill this command allows you to control the number of windows on your screen.
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Users Disable

By disabling a user, you cause incoming messages from that user to be ignored. Use this to filter out messages from
a user who is hogging the channel, or is otherwise being obnoxious. You identify the user to be disabled by choosing
his handle from a subordinate pulldown menu.

Users Enable

By enabling a user, you undo the effects of disabling that user. Once a user (again identified by handle) has been
enabled, incoming messages from that user will again be accepted.

Users Handle

This selection allows you to change your own handle (but nobody else’s). You are prompted for your new handle. In
response to this prompt, enter a string of up to 16 characters. There is no requirement that this handle be unique, al-
though things could conceivably get confusing if two or more users share a handle.

Users Page

This selection allows you to page a network user who is currently not on CB. This is the preferred way to send a
message to a person’s screen to the effect that he is wanted on CB. Since he is not already on CB, of course, you
can’t very well send him a CB message. And electronic mail won’t do because he may not read it for hours. So this
command invokes your network’s paging facility2 to send a short message to the person’s screen. All that you need
to know to use this command is the network name of the user. On some networks this is known as his login name.

Once the paged user has received this message, he can at his leisure invoke CB and join the conference.

The “Window” Menu

The “Window” pulldown menu controls various operations related to the current window.

Window Channel

This selection tunes the current window to the next channel which has been enabled. If there are currently two chan-
nels which have been enabled, then this command will tune the current window to the “other” one. If there are more
than two channels enabled, then subsequent invocations of this command will sequence through the entire list of
enabled channels. Of course, if there is only one channel which has been enabled then this command will have no ef-
fect.

Rather than having to go through the entire Pulldown Window Interface to accomplish this, you can accomplish the
same thing by pressing {Alt-C} from the main CB screen.

Window Next

This selection makes the next window on the screen the current window, assuming of course that you have at least
two windows on the screen. That window then becomes highlighted, and its transmit line becomes active.
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Open Open a new or existing Logfile, and start recording incoming messages to it. If
the file already exists then you are given the choice of appending to or overwrit-

ing the contents of the file.

Close Close an open Logfile. This is done automatically for you if you exit the pro-
gram with an open Logfile.

Annotate Write a one-line message to the Logfile. You are prompted for a line to be writ-
ten. That line is written to the open Logfile along with the current date and time.

File Quit

This selection allows you to exit from this program back to DOS. Any open files are automatically closed for you
before the program actually exits.

The “Help” Menu

The “Help” pulldown menu (see Figure 14) gives you access to the Online Help facility. The difference between ac-
cessing this facility through this menu and via pressing the {F1} key from the main CB screen is that this menu
gives you an index of the helpfile. By selecting an entry from this menu, you can enter the Online Help file at
precisely the screen which interests you.

The “Users” Menu

The “Users” pulldown menu allows you to perform various operations associated with users of CB.

Figure 14: The “Help” pulldown menu
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If a scrambled message is received by a user who has not scrambled the channel, it will not be displayed. If it is
received by a user who has scrambled the channel but who did not scramble it with exactly the same password, then
it may display as garbage on the screen.

A scrambled channel is identified by a “@” character before the channel identification in the window title line.

Channel Unscramble

This menu selection undoes the effect of scrambling a channel, so that once again messages will be sent and
received in the clear.

Channel Tune

This menu selection allows you to tune your current window to a specific channel. Whatever channel that window
was formerly tuned to becomes irrelevant. From now on that window will monitor messages from the newly-tuned
channel. Whatever channel you select is automatically enabled.

The “File” Menu

The “File” main menu choice gives you access to the various file- and DOS-related operations which can be per-
formed.

File DOS

This menu selection allows you to execute a DOS command from within this program. Enter the DOS command
which you want to execute. CB will pass that command to DOS for execution, and will then pause for you to press
the {Return} key before it clears the DOS screen and returns to the CB screen.

If you want to execute a series of DOS commands, then you may use this menu selection to enter the DOS command
interpreter COMMAND.COM. You indicate this by entering an empty command string (i.e. — you simply press
{Return} instead of entering a command to be executed). This causes CB to invoke COMMAND.COM, which dis-
plays the familiar DOS prompt and then processes your commands. To return to CB, issue the DOS command
“EXIT”.

File Transmit

This selection allows you to send an ASCII text file as if you typed it into the transmit line yourself. In fact, the file
may be transmitted in either of two modes:

Manual Each line of the file is read into the window’s transmit line, where you may then
edit it. The line will not be transmitted until you press {Return} as you would
for any transmit line.

Automatic Each line is read into the window’s transmit line, and then automatically trans-

mitted over the channel. You do not need to press {Return} to transmit a line.
Nor can you edit each line before it is sent.

File Logfile

This selection controls the Logfile, which is an ASCII file to which incoming messages are recorded. You may per-
form the following functions with the Logfile:
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Menu Positioning

CB makes every attempt to place pulldown menus in such a way that superior menus remain visible, so that you can
judge from the chain of displayed menus just exactly how you got where you are. However, CB won’t let menus
drop too far down the screen, or else they will obscure too much of the main CB screen.

Thus some menus may open up partially or completely on top of superior menus. And if a pulldown menu contains
more entries than can be shown within the relatively limited vertical space allocated for pulldown menus, then up
and/or down arrows will appear in the margins of the pulldown menu to indicate that more choices exist above or
below the indicated choices, which can be reached by scrolling the menu upward or downward with the appropriate
{Up}, {Down}, {PgUp}, or {PgDn} keypresses. Figure 14, for example, shows the “Help” pulldown menu. This
menu contains too many items to be shown at once, and a down arrow indicator (“↓”) in the lower right corner of
the menu box tells you that there are more choices below those which are shown.

Invoking the Pulldown Menu Interface

The Pulldown Menu Interface is invoked from the main CB screen by pressing {Alt-M} (that’s “M” as in “Menu”)
or the {F2} key. Once either key has been pressed, the top three lines of the screen are replaced with the main menu.
This is your point of entry into the menu system.

The “Channel” Menu

Choosing the “Channel” entry from the main menu opens a pulldown menu which shows the various operations that
may be performed upon CB channels.

Channel Disable

This menu item allows you to disable a given channel, which means that input from the given channel will be ig-
nored. You won’t see new messages from this channel on your screen, even if you have a window on your screen
which is currently tuned to that channel. More importantly, internal memory won’t be wasted holding messages
from this channel, which means that more memory will be available to hold messages that you are really interested
in, and DOS commands issued from within this program will have more memory in which to run.

A pulldown menu is presented which allows you to select the channel which is to be disabled.

Channel Enable

This menu choice allows you to enable a channel, which undoes the effects of a disabled channel. Messages from
the indicated channel will once again be accepted by this program, and passed to any windows which are tuned to
the given channel.

Channel Scramble

You may scramble a channel, which means that transmitted messages will be encrypted before they are transmitted
over a channel and decrypted upon receipt. This may be used to ensure a measure of privacy on the otherwise open
simulated airwaves.

When this menu selection is made, you are given the opportunity to select the channel which is to be scrambled.
You are then asked for a password to be used to scramble data on the channel. This password may be up to 8 charac-
ters long. This exact password must be used by all CB users who want to exchange scrambled messages!
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Pulldown Menus

A pulldown menu appears when a menu selection has sub-selections from which you may choose. One and only one
entry in this vertical menu is highlighted. You may move this highlight by pressing the keys {Up}, {Down},
{PgUp}, and {PgDn}. As you move the highlight, the description on the second line of the screen changes to suit
the entry that is highlighted. In this manner you may browse up and down through the various menu entries until you
arrive at just the one that you want.

As with the horizontal main menu, an item is selected from a vertical pulldown menu by moving the highlight to the
desired entry and pressing the {Return} key.

Context-sensitive Help

The short description on the second line of the screen might not give you enough information about the highlighted
choice to satisfy you. As mentioned previously, the {F1} key may be pressed to obtain a more explicit hint. This
causes a hint box to appear which more fully describes the highlighted choice.

Backing Out

The {Escape} key serves to back out of the current menu. This returns you to the prior menu from which the cur-
rent menu was selected. If pressed when only the main menu is on the screen, this keypress will exit the Pulldown
Menu Interface back to the main CB screen.

Main Menu Line

Description of
current choice

Main Menu
selection

Pulldown Menus

Hint for current
choice

Figure 13: Components of the Pulldown Menu Interface
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The Pulldown Menu Interface

NOTE: While in the Pulldown Menu Interface, communications are temporarily frozen. They
will be resumed when you exit the Pulldown Menu Interface and return to the main CB

screen.

Much can be accomplished with CB without ever leaving the main screen. CB, however, is much more powerful
than that main screen would indicate.

In order to keep the main screen as simple and clean as possible, it has not been cluttered with the dozens of com-
mands that control CB’s more advanced operations. Instead, these additional commands have been gathered together
into an easy-to-use Pulldown Menu Interface.

Components of the Pulldown Menu Interface

The Pulldown Menu Interface is inherently different from the command-driven interface used in the main screen.
There are many available commands, and the menu approach is designed to let you see all available options before
you choose one, and to browse through those choices without necessarily committing yourself. Lastly, it allows you
to back out of one series of menus, to pursue another menu path if you choose to.

Please refer to Figure 13, which shows the screen as it might appear after navigating the menus down a certain dis-
tance. This will serve as an example of the various pieces of the menu interface.

The Main Menu Line

The topmost line of the screen has been replaced with the main menu line. This presents the various general
categories of commands which are supported by the menu system. One and only one of the names on this line will
be highlighted. This highlight is moved by using the {Left} and {Right} keys, and defines the current main menu

selection. As you move this highlight, the second line of the screen changes. This line always holds a short descrip-
tion of the highlighted selection. In other words, this line tells you what you will be doing if you choose the high-
lighted menu selection.

Once you have highlighted the main menu choice that you want to descend, you select that choice by pressing the
{Return} key1. A pulldown menu then appears below the selected main menu choice.
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1 Alternatively, you may select an entry in this (or any other) menu by pressing the key which corresponds to the letter in each entry which is
in a different color.


